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About This Guide

This ZENworks Server Installation Guide includes information to help you successfully create a 
ZENworks Management Zone. 

Before getting started with the creation of the Management Zone, ensure that you go through the 
Installation Overview section.

Audience
This guide is intended for ZENworks administrators.

Feedback
We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
Online documentation.

Additional Documentation
ZENworks is supported by other documentation (in both PDF and HTML formats) that you can use to 
learn about and implement the product. For additional documentation, see the ZENworks 
documentation Web site.
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1 1Installation Overview

ZENworks 23.4 supports Windows, Linux, and Appliance. Setting-up a new ZENworks Management 
Zone with Windows or Linux server using ZENworks 23.4 Installer is not supported as the ZENworks 
23.4 does not include an ISO based installer. However, you can use ZENworks 23.4 Appliance to 
setup a new zone.

If you want to setup a new zone using Windows or Linux Servers, you can use ZENworks 2020 Update 
2 and then apply ZENworks 23.4 system update.

For more information on the product overview and know more about Primary Servers, Satellite 
Servers, ZENworks Agents, see ZENworks Overview. If you are not sure about Install, Upgrade or 
Update, see ZENworks - Do I Install, Upgrade, or Update?.

Depending on your requirements, you can refer to the following sections:

Creating a New Management Zone: 

 Appliance Deployment (ZENworks 23.4)
 New Management Zone (ZENworks 2020 Update 2)

— Using Windows as a Primary Server
— Using Linux as a Primary Server

After creating the ZENworks Management Zone (2020 Update 2), update to ZENworks 23.4. For 
more information, see ZENworks System Updates Reference 

NOTE: ZENworks 23.4 is the last version that supports Windows Primary Server.

Adding a new Server to an Existing Management Zone 

 Adding a New Windows Primary Server (ZENworks 23.4)
 Adding a New Linux Primary Server (ZENworks 23.4)
 Configuring the Additional Primary Servers (ZENworks 23.4 Appliance)
Installation Overview 7
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I IWindows Installation

The following section provides information and instructions to help you install the ZENworks Primary 
Server software on a Windows server:

 Chapter 2, “Windows Installation Workflow,” on page 11
 Chapter 3, “Adding a New Windows Primary Server,” on page 13
 Chapter 4, “Completing Post-Installation Tasks on Windows Servers,” on page 19
Windows Installation 9
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2 2Windows Installation Workflow

By using the ZENworks 23.4 ISO you will only be able to add a new Primary Server to an existing 
zone. However, if you are planning to deploy the ZENworks Appliance, then you can create a new 
Management Zone or add a new Primary Server to an existing zone.

For more information on ZENworks Appliance, see  ZENworks Appliance Deployment and 
Administration Reference.

The following sections provides a step-by-step procedure to add a new Primary Servers (secondary) 
to an existing ZENworks Management Zone. 

 ZENworks Installation Workflow for Additional Windows Primary Servers
 Understanding What the ZENworks Installation Does
 Adding a New Windows Primary Server

ZENworks Installation Workflow for Additional Windows 
Primary Servers

To add a new Primary Server to your existing ZENworks Management Zone, complete the tasks in 
the order listed below.

Task Details

 Review what the ZENworks installation program 
does when adding a Primary Server to an existing 
Management Zone. 

When installing an additional Primary Server in a 
Management Zone, the installation program 
performs operations to install the Primary Server 
software, add the Primary Server to the existing 
Management Zone, install ZENworks Control 
Center, and start the ZENworks services.

 Update the software on the Windows server 
where you will install the ZENworks Primary 
Server.

Ensure that the Windows server software is up to 
date and that any software, such as anti-virus 
software, that might interfere with the Primary 
Server installation is updated and configured 
correctly.
Windows Installation Workflow 11
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Understanding What the ZENworks Installation Does
The ZENworks installation program does the following during installation of any Primary Server:

 Installs the ZENworks Agent so that the server can be managed
 Installs ZENworks Control Center, the web console used to manage your ZENworks System 
 Installs the zman command line utility
 Installs and starts the ZENworks services

 (Optional) Create an external certificate for your 
Primary Server.

If your ZENworks Management Zone is using the 
internal ZENworks Certificate Authority (CA), the 
new Primary Server is automatically issued a 
server certificate during installation. 

If your zone is using an external CA, you must 
provide the new Primary Server with a valid 
certificate issued from the external CA.

For instructions about creating a certificate from 
an external CA, see Appendix A, “Creating an 
External Certificate,” on page 43.

 Install the ZENworks Primary Server software on 
a supported Windows server.

Installation of an additional Primary Server is less 
complex than installation of the first Primary 
Server. The installation program only requires 
you to provide a target location for the software 
files, authentication information for the 
Management Zone (Primary Server address and 
Administrator login credentials), and files for the 
external certificate (if the zone is using an 
external CA).

 Verify that the Primary Server is running. There are specific checks you can perform to 
ensure that installation of the software was 
successful and that the Primary Server is running.

 Back up the ZENworks Primary Server. You should back up the Primary Server at least 
one time.

For instructions, see “Backing Up ZENworks 
Components” on page 21.

 Review the post-installation tasks and complete 
any that apply to your Primary Server installation.

There are several post-installation tasks that you 
might need to perform for your Primary Server. 
Review the list of tasks and complete any that 
apply.

For instructions, see Chapter 4, “Completing 
Post-Installation Tasks on Windows Servers,” on 
page 19.

Task Details
12 Windows Installation Workflow



3 3Adding a New Windows Primary Server

This section provides a step-by-step procedure to add a new Primary Servers (secondary) to an 
existing ZENworks Management Zone. 

 “Prerequisites” on page 13
 “Adding a new Primary Server to an Existing Management Zone” on page 13

Prerequisites
Before starting the procedure, ensure that you go through the following points:

 Ensure that the new server that you are adding to the zone meets all the requirements. For 
more information, see ZENworks System Requirements in the ZENworks Documentation site.

 Ensure that the first Primary Server is at ZENworks 23.4. If the first Primary Server is at a lesser 
version, then installation might fail.

 The first Primary Server should be up and running. 
 If you are using an external database, then ensure that the database is up and running.
 If your ZENworks Management Zone is using the internal ZENworks Certificate Authority (CA), 

the new Primary Server is automatically issued a server certificate during installation.
 If your zone is using an external CA, you must provide the new Primary Server with a valid 

certificate issued from the external CA.
 Ensure that you have taken a reliable backup of the Primary Server.

Adding a new Primary Server to an Existing Management 
Zone

Installation of an additional Primary Server is less complex than installation of the first Primary 
Server. The procedure only requires you to provide a target location for the software files, 
administrator credentials, Primary Server Address, and files for the external certificate (if the zone is 
using an external CA)

Perform the following steps to add a new Primary Server:

1 On the server, download and mount the ZENworks ISO.
2 Run setup.bat.

A command prompt will be displayed. Wait for a few minutes to display the configuration 
information which includes URLs and credentials to log into the ZENworks configuration wizard.

3 On the server that you want to add as Primary Server, open the URL in one of the ZENworks-
supported browsers. 
This URL can be accessed on any device within the network.
Adding a New Windows Primary Server 13
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4 In the login page, specify the username and password that is displayed in the command prompt.
5 After login, the ZENworks License Agreement page is displayed. 

Accept the terms of the license and click Accept.
6 In the Configure ZENworks Primary Server screen, select the Add this server to an existing 

Management Zone option, and then click Next.

7 The Installation Directory screen is displayed. In this screen, specify a valid path where 
ZENworks should be installed, and then click Next.

If you are using a Linux server, then this screen will not be displayed.
8 In the background, a system requirement check will be performed. 

If the requirements are not met, then the essential system requirements will be displayed. 
If errors are displayed, then you will not be able to proceed with the installation. Ensure that 
you adhere to the requirements before proceeding with the installation. 
After making the necessary changes, click re-run System Check, to perform the system 
requirement check. 

NOTE: If the server meets all the requirements, then the System Requirements Check screen 
will not be displayed.

For more information, go through the system requirements in the ZENworks documentation 
site.

9 Click Next. 
10 In the Connect to an Existing Primary Server screen, perform the following actions, and then 

click Next:
10a Primary Server: Specify the IP address or FQDN of the first Primary Server.
10b Port: Specify the port used by the first Primary Server.
14 Adding a New Windows Primary Server



10c Administrator: Specify the ZENworks administrator username.
10d Password: Specify the ZENworks administrator password.

The specified credentials will be validated. 
11 If the specified credentials are valid, then you will be asked to validate the Primary Server 

Certificate.
If you are using an external CA, and if the certificate is not from a well known CA, then the 
following screen might be displayed.

12 Accept the certificate, and then click Confirm.
13 In the Open Ports page, ports that are needed by ZENworks are currently blocked by the 

server's Firewall is displayed. 
Open the ports, and then click Next.

The opened ports will be left open after completing the installation.
14 If the existing ZENworks Management Zone is using an internal CA, the new Primary Server is 

automatically issued a server certificate during installation. 
Adding a New Windows Primary Server 15



For the server certificate validity specify a value between 1 and 10 for which the certificate 
should be valid.
If you are planning to use this server to manage mobile devices, then ensure that the certificate 
validity duration should not exceed 2 years.

Specify the validity of the server certificate, and then click Next.
15 If you are using an external CA, then specify certificate details for the additional Primary Server.

 If an External certificate is used in the first Primary Server, choose the required certificate 
(Server Certificate with Private Key or Server Certificate). If you have used the Generate CSR 
link, then upload Server Certificate. Based on the certificate specify the following details: 
 Server Certificate: Browse to the signed certificate to be used for this server.

The certificate must be a SubCA (approved by SubCA) and CA (Approved by root CA) 
certificates in order:
====Beginning of the Certificate File====
=[Server Certificate]=
=[SubCA Certificate]=
=[CA Certificate]=
====End of the Certificate File====

 Private Key File: This field is enabled if you select the Server Certificate with Private 
Key option. Browse to the .der  private key file that is associated with the signed 
certificate.
To convert the PEM file to DER file, use the following command:
openssl pkcs8 –topk8 –nocrypt –in privateKey.key –inform PEM –
out key.der –outform DER
To verify the privateKey.key file, use the following command:
openssl rsa -in privateKey.key -check

16 The Summary page displays all the information that was provided while configuring. If any 
modifications are needed, click Previous. 
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17 To initiate the installation, click Install. 
ZENworks installation will be initiated, and the status of the installation will be displayed.

After the installation is completed, you will be asked to restart the system. You can either 
reboot the server, or you can reboot the server later.

It is recommended that you restart the server so that settings are applied successfully.
After successfully adding the new Primary server, ensure that you go through Completing Post-
Installation Tasks on Windows Servers.
Adding a New Windows Primary Server 17



If the installation fails, then a link to download the log files will be displayed on the screen. click 
the link and download the log files to troubleshoot the issues.
If you are facing any issues, then go through the Troubleshooting section.
18 Adding a New Windows Primary Server



4 4Completing Post-Installation Tasks on 
Windows Servers

After successfully installing the ZENworks Primary Server software, you might need to perform some 
of the following post-installation tasks. Not all tasks are required for all installations. However, we 
recommend that you review each section to ensure that you complete any tasks required for your 
installation.

 “Licensing Products” on page 19
 “Enabling Access to a Primary Server Behind a NAT Firewall” on page 20
 “Adding Imaging Applications as Firewall Exceptions” on page 20
 “Backing Up ZENworks Components” on page 21
 “Customizing ZENworks Control Center” on page 21
 “Supporting a Primary Server on VMware ESX” on page 21

Licensing Products 
During the installation of your first ZENworks Primary Server and the creation of your Management 
Zone, the ZENworks installation program installs the following products and sets their license state 
as listed in the table.

You activate a product by supplying a valid product license. If you do not have a valid license, you can 
evaluate the product for 60 days. 

To change the license state of a product:

1 Log in to ZENworks Control Center.
2 Click Configuration.

Product License State

Asset Inventory for Linux Evaluation

Asset Inventory for Windows/
Macintosh

Deactivated

Asset Management Evaluation

Configuration Management Evaluation

Endpoint Security Management Deactivated

Full Disk Encryption Deactivated

Patch Management Activated
Completing Post-Installation Tasks on Windows Servers 19



3 In the Licenses panel, click a suite if you have a suite license key.
or
Click a product to provide a product license key or to turn on the product evaluation.

For more information about activating and deactivating products, see the ZENworks Product 
Licensing Reference.

Enabling Access to a Primary Server Behind a NAT Firewall
If the Primary Server is behind a NAT firewall, the devices on the Internet or public network cannot 
communicate with it. To resolve the issue, you must configure additional IP addresses or DNS names 
for the Primary Server through ZENworks Control Center.

For more information, see “Configuring Additional Access to a ZENworks Server” in the ZENworks 
Primary Server and Satellite Reference.

Adding Imaging Applications as Firewall Exceptions
The ZENworks installation program cannot add exceptions to a Windows server firewall. Therefore, 
you must manually complete this task under the following conditions:

 The Primary Server will be an Imaging Server.
 The Primary Server will be the parent Primary Server of an Imaging Satellite Server. 

Refer to the appropriate section for the Primary Server’s operating system:

 “Adding Imaging Applications as Firewall Exceptions on Windows Server 2012 and 2016” on 
page 20

Adding Imaging Applications as Firewall Exceptions on Windows 
Server 2012 and 2016

1 Open Control Panel, and then open Windows Firewall.
2 In the left pane, click the Allow an app or feature through Windows Firewall option.
3 In the Allowed apps window, click Allow another app.
4 In the Add an app window, click Browse and select the novell-pbserv.exe application.

All Imaging applications, are located in the 
%zenworks_home%\novell\zenworks\bin\preboot directory.

5 After selecting the application, click Add.
6 Repeat Step 4 and Step 5, add the following Imaging applications to the Allowed apps and 

features list, and then click OK:
 novell-proxydhcp.exe 
 novell-tftp.exe 
 novell-zmgprebootpolicy.exe
20 Completing Post-Installation Tasks on Windows Servers
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Backing Up ZENworks Components 
We recommend that you implement the following backup best practices:

 Take reliable backups of the ZENworks database and Audit database on a regular basis. For 
instructions, see the ZENworks Database Management Reference.

 Procure and note the credentials of the databases:
 For the embedded PostgreSQL ZENworks database, use the following command: 

zman dgc -U administrator_name -P administrator_password

 For the embedded PostgreSQL Audit database, use the following command: 
zman dgca -U admimistrator_name -P administrator_password

 For an external database, contact the database administrator.
 Take a reliable backup of the Primary Server (this only needs to be done one time). For 

instructions, see “Backing Up and Restoring the ZENworks Server and Certificate Authority”in 
the ZENworks Disaster Recovery Reference.

 Take a reliable backup of the Certificate Authority. For instructions, see “Backing Up the 
Certificate Authority”in the ZENworks Disaster Recovery Reference.

Customizing ZENworks Control Center
ZENworks Control Center provides a configuration file that you can use to customize how it 
functions. For example, you can change the default timeout from 30 minutes to another value.

For instructions, see “Customizing ZENworks Control Center” in the ZENworks Control Center 
Reference.

Supporting a Primary Server on VMware ESX 
If you installed the Primary Server software on a virtual machine running on VMware ESX, complete 
the following tasks:

 “Adjusting the Reserved Memory Size” on page 21
 “Enabling Large Page Support” on page 22

Adjusting the Reserved Memory Size
For optimal performance, set the reserved memory size to the size of the guest operating system 
memory. For more information, see TID 7005382 in Novell Support Knowledgebase (http://
support.novell.com/search/kb_index.jsp).
Completing Post-Installation Tasks on Windows Servers 21
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Enabling Large Page Support
For optimal performance of large dataset handling, you should enable Java large page support:

1 At the server’s command prompt, run the following command to launch the ZENworks Server 
Properties dialog box:
ZENworksAdminMgmtw

2 In the Java tab, add the following option to the Java Options box:
-XX:+UseLargePages
Ensure that you add the option on its own line.

3 Restart the Primary Server:
3a Click Start > Settings > Control Panel > Administrative Tools > Services.
3b Select Micro Focus ZENworks Administration Management, then click Restart in the left 

pane.

NOTE: If the ZENworks Administration Management service fails to start, there is a compatibility 
problem with the newly added option, or the syntax is incorrect. 

The log file is available in the following location which includes all the error information:

%ZENSERVER_HOME%\logs\admin-mgmt\catalina.out
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II IILinux Installation

The following section provides information and instructions to help you install the ZENworks Primary 
Server software on a Linux server:

 Chapter 5, “Linux Installation Workflow,” on page 25
 Chapter 6, “Adding a New Linux Primary Server,” on page 27
 Chapter 7, “Completing Post-Installation Tasks on Linux Servers,” on page 37
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5 5Linux Installation Workflow

By using the latest ZENworks ISO, you will only be able to add a new Primary Server to an existing 
zone. However, if you are deploying the ZENworks Appliance, then you can create a new 
Management Zone or add a new Primary Server to an existing zone.

For more information on ZENworks Appliance, see  ZENworks Appliance Deployment and 
Administration Reference.

The following sections provides a step-by-step procedure to add a new Primary Servers (secondary) 
to an existing ZENworks Management Zone. 

 Installation Workflow for Additional Linux Primary Servers
 Understanding What the ZENworks Installation Does
 Adding a New Linux Primary Server

Installation Workflow for Additional Linux Primary Servers
To install a ZENworks Primary Server and add it to your existing ZENworks Management Zone, 
complete the tasks in the order listed below.

Task Details

 Install the required software on the Linux device 
before you start the ZENworks installation.

Before installing ZENworks on a Linux Primary 
Server, you are required to install Docker and 
Docker Compose on the server. For more 
information on Dockers, seehttps://
docs.docker.com/.

For more information on Installing Docker and 
Docker Compose see, Installing Docker and 
Docker Compose.

 Review what the ZENworks installation does 
when adding a Primary Server to an existing 
Management Zone. 

When installing an additional Primary Server in a 
Management Zone, the installation program 
performs operations to install the Primary Server 
software, add the Primary Server to the existing 
Management Zone, install ZENworks Control 
Center, start the ZENworks services.

 Update the software on the Linux server where 
you will install the ZENworks Primary Server.

Ensure that the Linux server software is up to 
date and that any software, such as anti-virus 
software, that might interfere with the Primary 
Server installation is updated and configured 
correctly.
Linux Installation Workflow 25

https://docs.docker.com/
https://docs.docker.com/
https://www.novell.com/documentation/zenworks-23.4/pdfdoc/zen_ca_appliance/zen_ca_appliance.pdf#bookinfo
https://www.novell.com/documentation/zenworks-23.4/pdfdoc/zen_ca_appliance/zen_ca_appliance.pdf#bookinfo


Understanding What the ZENworks Installation Does
The ZENworks installation program does the following during installation of any Primary Server:

 Installs the ZENworks Agent so that the server can be managed
 Installs ZENworks Control Center, the web console used to manage your ZENworks System 
 Installs the zman command line utility
 Installs and starts the ZENworks services

 (Optional) Create an external certificate for your 
Primary Server.

If your ZENworks Management Zone is using the 
internal ZENworks Certificate Authority (CA), the 
new Primary Server is automatically issued a 
server certificate during installation. 

If your zone is using an external CA, you must 
provide the new Primary Server with a valid 
certificate issued from the external CA. 

For instructions about creating a certificate from 
an external CA, see Appendix A, “Creating an 
External Certificate,” on page 43.

 Install the ZENworks Primary Server software on 
a supported Linux server.

Installation of an additional Primary Server is less 
complex than installation of the first Primary 
Server. The installation program only requires 
you to provide a target location for the software 
files, authentication information for the 
Management Zone (Primary Server address and 
Administrator login credentials), and files for the 
external certificate (if the zone is using an 
external CA).

 Verify that the Primary Server is running. There are specific checks you can perform to 
ensure that installation of the software was 
successful and that the Primary Server is running.

For instructions, see “Verifying the Installation” 
on page 34.

 Back up the ZENworks Primary Server. You should back up the Primary Server at least 
one time.

For instructions, see “Backing Up ZENworks 
Components” on page 38.

 Review the post-installation tasks and complete 
any that apply to your Primary Server installation.

There are several post-installation tasks that you 
might need to perform for your Primary Server. 
Review the list of tasks and complete any that 
apply.

For instructions, see Chapter 7, “Completing 
Post-Installation Tasks on Linux Servers,” on 
page 37.

Task Details
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6 6Adding a New Linux Primary Server

This section provides a step-by-step procedure to add a new Primary Servers (secondary) to an 
existing ZENworks Management Zone

 “Installing Docker and Docker Compose” on page 27
 “Zocker” on page 30
 “Adding a New Primary Server” on page 30
 “Verifying the Installation” on page 34

NOTE: After installing the first Primary Server, ZooKeeper is automatically enabled on the first 
Primary Server. You need to ensure that ZooKeeper is up and running at all times.

Installing Docker and Docker Compose
As ZENworks aims to adopt a more robust and flexible architecture, you are required to install 
Docker and Docker Compose on the Linux Primary Server on which the ZENworks server software 
will be installed.

 Docker Version: Docker v19.x or higher should be installed on the server on which the 
ZENworks Primary Server software will be installed. 

 Docker Compose Version: Docker Compose v1.28.x or higher should be installed on the server 
on which the ZENworks Primary Server software will be installed.

 “Installing Docker” on page 27
 “Installing Docker Compose” on page 28
 “Changing the Internal Docker IP” on page 29

Installing Docker
The procedure detailed in this section will enable you to download the latest version of Docker.

1 After registering to SUSE Customer Center, generate a registration key for the operating system 
version of your Primary Server and register the device with the SUSE Customer Center.

2 Start YaST.
3 In the Administrator Settings window, select Software > Software Repositories.
4 Click Add to open the Add On Product dialog box. 
5 Select Extensions and Modules from the Registration Server.... Click Next.
6 From the list of Available Extensions and Modules, based on the platform version, select one of 

the following container modules. Click Next and Finish the wizard. The modules and its 
repositories will be added to your system. 
 SLES 12 SP3, SLES 12 SP4, SLES 12 SP5: Containers Module 12 x86_64
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 SLES 15: Containers Module 15 x86_64
 SLES 15 SP1: Containers Module 15 SP1 x86_64

7 On the Linux terminal, execute the following command to install the Docker package:

$ sudo zypper install docker

NOTE: If the zypper install docker command fails to install docker, then run the following 
command to check whether the container module has been added to the repository:

$ sudo zypper ls
If the container module has not been added, then run the following command to add the 
container module:
For SLES 12 SP3, SLES 12 SP4, SLES 12 SP5:

$ sudo SUSEConnect -p sle-module-containers/12/x86_64
For SLES 15:

$ sudo SUSEConnect -p sle-module-containers/15/x86_64
For SLES 15 SP1:

$ sudo SUSEConnect -p sle-module-containers/15.1/x86_64

8 Execute the following command to enable the Docker services:

$ sudo systemctl enable docker.service
9 Execute the following command to start the Docker service:

$ sudo systemctl start docker.service
10 Execute the following command to test whether Docker has been installed properly:

$ docker run hello-world
If the message Hello from Docker! is displayed, then it indicates that Docker has been 
installed successfully.

Installing Docker Compose
Before installing Docker Compose, ensure that you have already installed the Docker engine as 
elaborated in the previous section.

1 On the Linux terminal, run the following command to download the latest release of Docker 
Compose, in this case Docker Compose version 1.28.2:

$ sudo curl -L "https://github.com/docker/compose/releases/download/
1.28.2/docker-compose-$(uname -s)-$(uname -m)" -o /usr/local/bin/
docker-compose

NOTE: If the server does not have Internet access and communicates through a proxy server, 
then refer to the curl man page for configuring curl to use proxy.

2 Run the following command to apply executable permissions to the binary:
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$ sudo chmod +x /usr/local/bin/docker-compose

NOTE: If the docker-compose command fails after installation, check the path. You can also 
create a symbolic link to /usr/bin or any other directory in your path.
Example:

$ sudo ln -s /usr/local/bin/docker-compose /usr/bin/docker-compose

3 Test the installation by running the following command. The Docker Compose version will be 
displayed.

$ docker-compose --version

NOTE: The latest release versions of Docker Compose is published in https://github.com/docker/
compose/releases. To upgrade to the latest release, follow the steps displayed under the Linux tab in 
https://docs.docker.com/compose/install/. However, before upgrading Docker Compose to the 
latest version, ensure that you stop the ZENworks services. For more information on stopping these 
services, see Stopping the ZENworks Services.

Changing the Internal Docker IP
By default, docker internally uses the IP 172.17.0.1/16. In case this IP conflicts with any other device 
or network in your organization, only then the docker IP should be changed.

To change the internal docker IP that is being used, perform the following steps:

1. Stop all the ZENworks services by running the microfocus-zenworks-configure -c 
Start command.

2. Modify the daemon.json file available in the /etc/docker/, and add the line 
"bip":"<IP_address>", to the start of the file, as shown in the below image:

NOTE: You can use any private IP that is not being used by your organization. 
In above example we have used 192.168.2.1/24

3. Restart the docker service by running the following command:
systemctl restart docker

4. Start all the ZENworks services by running the microfocus-zenworks-configure -c 
Start command.
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Zocker
Zocker is used for patching the Primary Servers in the zone. 

Applying the Zocker Patch 

The patch can be applied on both Windows and Linux. To apply the patch run the following 
command: 

zocker patch apply -file <location_ patch.tar>

Example: zocker patch apply -file D:\patchfile20.2.0.567.tar

Reverting the Patch 

Using the revert command, you can revert to the last good-known version or a specific version. To 
revert the patch, run the following command:

 To revert to a last known good version: zocker patch revert -image zenserver
 To revert to a specific version: zocker patch revert -image zenserver:<version>

Example: zocker patch revert -image zenserver:20.2.0.567
The server will be reverted to the 20.2.0.567 version.

Adding a New Primary Server
This section provides a step-by-step procedure to add new Primary Servers (secondary) to an 
existing ZENworks Management Zone. 

Prerequisites
Before starting the procedure, ensure that you go through the following points:

 Ensure that the new server that you are adding to the zone meets all the requirements. For 
more information, see System Requirements in the ZENworks Documentation site.

 Ensure that you have installed Docker and Docker Compose on the Linux Primary Server on 
which the ZENworks server software will be installed.

 Ensure that the first Primary Server is at ZENworks 23.4. If the first Primary Server is at a lesser 
version, then installation might fail.

 The first Primary Server should be up and running. 
 If you are using an external database, then ensure that the database is up and running.
 If your ZENworks Management Zone is using the internal ZENworks Certificate Authority (CA), 

the new Primary Server is automatically issued a server certificate during installation.
 If your zone is using an external CA, you must provide the new Primary Server with a valid 

certificate issued from the external CA.
 Ensure that you have taken a reliable backup of the Primary Server.
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Adding a new Primary Server to an Existing Management Zone
Installation of an additional Primary Server is less complex than installation of the first Primary 
Server. The procedure only requires you to provide a target location for the software files, 
administrator credentials, Primary Server Address, and files for the external certificate (if the zone is 
using an external CA)

Perform the following steps to add a new Primary Server:

1 Log into the installation server as a Linux administrator.
2 Download the ZENworks ISO.
3 Mount the ISO by running the command mount -o loop <ISO path including name> 

<mount_path>.
4 cd to the mounted location and run ./setup.sh.

A command prompt will be displayed. Wait for a few minutes to display the configuration 
information which includes URLs and credentials to log into the ZENworks configuration wizard.

5 On the server that you want to add as Primary Server, open the URL in one of the ZENworks-
supported browsers. 
This URL can be accessed on any device within the network.

6 In the login page, specify the username and password that is displayed in the command prompt.
7 After login, the ZENworks License Agreement page is displayed. 

Accept the terms of the license and click Accept.
8 In the Configure ZENworks Primary Server screen, select the Add this server to an existing 

Management Zone option, and then click Next.

9 In the background, a system requirement check will be performed. 
If the requirements are not met, then the essential system requirements will be displayed. 
If errors are displayed, then you will not be able to proceed with the installation. Ensure that 
you adhere to the requirements before proceeding with the installation. 
After making the necessary changes, click re-run System Check, to perform the system 
requirement check. 
Note: If the server meets all the requirements, then the System Requirements Check screen will 
not be displayed.
For more information, go through the system requirements in the ZENworks documentation 
site.
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10 Click Next. 
11 In the Connect to an Existing Primary Server screen, perform the following actions, and then 

click Next:
11a Primary Server: Specify the IP address or FQDN of the first Primary Server.
11b Port: Select the port used by the first Primary Server.
11c Administrator: Specify the ZENworks administrator username.
11d Password: Specify the ZENworks administrator password.

The specified credentials will be validated. 
12 If the specified credentials are valid, then you will be asked to validate the Primary Server 

Certificate, if the first Primary Server is using an internal certificate.
If you are using an external CA, and if the certificate is not from a well known CA, then the 
following screen might be displayed.

13 Accept the certificate, and then click Confirm.
14 In the Open Ports page, ports that are needed by ZENworks are currently blocked by the 

server's Firewall is displayed. 
Open the ports, and then click Next.
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The opened ports will be left open after completing the installation.
15 If the existing ZENworks Management Zone is using an internal CA, the new Primary Server is 

automatically issued a server certificate during installation. 
For the server certificate validity specify a value between 1 and 10 for which the certificate 
should be valid.
If you are planning to use this server to manage mobile devices, then ensure that the certificate 
validity duration should not exceed 2 years.

Specify the validity of the server certificate, and then click Next.
16 If you are using an external CA, then specify certificate details for the additional Primary Server.

 If an External certificate is used in the first Primary Server, choose the required certificate 
(Server Certificate with Private Key or Server Certificate). If you have used the Generate CSR 
link, then upload Server Certificate. Based on the certificate specify the following details: 
 Server Certificate: Browse to the signed certificate to be used for this server.

The certificate must be a SubCA (approved by SubCA) and CA (Approved by root CA) 
certificates in order:
====Beginning of the Certificate File====
=[Server Certificate]=
=[SubCA Certificate]=
=[CA Certificate]=
====End of the Certificate File====

 Private Key File: This field is enabled if you select the Server Certificate with Private 
Key option. Browse to the .der  private key file that is associated with the signed 
certificate.
To convert the PEM file to DER file, use the following command:
openssl pkcs8 –topk8 –nocrypt –in privateKey.key –inform PEM –
out key.der –outform DER
Adding a New Linux Primary Server 33



To verify the privateKey.key file, use the following command:
openssl rsa -in privateKey.key -check

17 The Summary page displays all the information that was provided while configuring. If any 
modifications are needed, click Previous. 

18 To initiate the installation, click Install. 
ZENworks installation will be initiated, and the status of the installation will be displayed.

After successfully adding the new Primary server, ensure that you go through Completing Post-
Installation Tasks on Linux Servers.
If the installation fails, then a link to download the log files will be displayed on the screen. click 
the link and download the log files to troubleshoot the issues.
If you are facing any issues, then go through the Troubleshooting section.

Verifying the Installation
Perform the following steps if you want to verify a successful installation.

1 After the installation has completed, do any of the following to verify that ZENworks is running:
 Run ZENworks Control Center 

If ZENworks Control Center did not automatically start, use the following URL to open it in a 
web browser:
https://DNS_name_or_IP_address_of_Primary_Server/zenworks
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NOTE: If the Primary Server is not using the default HTTPS port, you must add the port to 
the URL: https://DNS_name_or_IP_address_of_Primary_Server:port_number/zenworks

This can be done either on the server where you just installed ZENworks, or on a qualified 
workstation.

 Check the Linux services by using the configuration command 
On the server, run the following command:

/opt/microfocus/zenworks/bin/microfocus-zenworks-configure 
-c SystemStatus
This lists all ZENworks services and their statuses.
To start the services, run the following command:

/opt/microfocus/zenworks/bin/microfocus-zenworks-configure -c Start
 Check the Linux services by using the specific services’ commands 

On the server, run the following commands:
microfocus-zenworks-configure -c Start
If the services are not running, run the following commands to start the ZENworks services:
microfocus-zenworks-configure -c Start
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7 7Completing Post-Installation Tasks on Linux 
Servers

After successfully installing the ZENworks Primary Server software, you might need to perform some 
of the following post-installation tasks. Not all tasks are required for all installations. However, we 
recommend that you review each section to ensure that you complete any tasks required for your 
installation. 

 “Licensing Products” on page 37
 “Adding Imaging Applications as Firewall Exceptions” on page 38
 “Supporting ZENworks 11.x Device Upgrades” on page 38
 “Backing Up ZENworks Components” on page 38
 “Customizing ZENworks Control Center” on page 39
 “Tasks for VMware ESX” on page 39

Licensing Products 
During the installation of your first ZENworks Primary Server and the creation of your Management 
Zone, the ZENworks installation program installs the following products and sets their license state 
as listed in the table.

You activate a product by supplying a valid product license. If you do not have a valid license, you can 
evaluate the product for 60 days. 

To change the license state of a product:

1 Log in to ZENworks Control Center.
2 Click Configuration.

Product License State

Asset Inventory for Linux Evaluation

Asset Inventory for Windows/
Macintosh

Deactivated

Asset Management Evaluation

Configuration Management Evaluation

Endpoint Security Management Deactivated

Full Disk Encryption Deactivated

Patch Management Activated
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3 In the Licenses panel, click a suite if you have a suite license key.
or
Click a product to provide a product license key or to turn on the product evaluation.

For more information, see the ZENworks Product Licensing Reference.

Adding Imaging Applications as Firewall Exceptions
The ZENworks installation program cannot add exceptions to a Linux server firewall. Therefore, you 
must manually complete this task under the following conditions:

 The Primary Server will be an Imaging Server.
 The Primary Server will be the parent Primary Server of an Imaging Satellite Server. 

If you turn on the firewall on the Primary Server, you must configure the server to allow the 
following ZENworks Imaging applications through the firewall by adding them to the Firewall 
Exceptions list:

 novell-pbserv.exe
 novell-proxydhcp.exe
 novell-tftp.exe
 novell-zmgprebootpolicy.exe

Supporting ZENworks 11.x Device Upgrades
If you have ZENworks 11.x managed devices or Satellite Servers in your network and want to register 
the devices to a new ZENworks Management Zone so that they can be automatically upgraded to 
ZENworks, you must import the ZENworks System Update into the zone from the ZENworks 
installation media. 

Backing Up ZENworks Components
We recommend that you implement the following backup best practices:

 Take a reliable backup of the ZENworks database and Audit database on a regular basis. For 
more information on how to back up the ZENworks database, see the ZENworks Database 
Management Reference.

 Procure and note down the credentials of the database.
 For an internal database, use the following commands: 
zman dgc -U administrator_name -P administrator_password

 For the embedded PostgreSQL audit database, use the following commands: 
zman dgca -U admimistrator_name -P administrator_password

 For an external database, contact the database administrator.
38 Completing Post-Installation Tasks on Linux Servers

https://www.novell.com/documentation/zenworks-23.4/pdfdoc/zen_sys_licensing/zen_sys_licensing.pdf#bookinfo
https://www.novell.com/documentation/zenworks-23.4/pdfdoc/zen_sys_db_mgmt/zen_sys_db_mgmt.pdf#bookinfo
https://www.novell.com/documentation/zenworks-23.4/pdfdoc/zen_sys_db_mgmt/zen_sys_db_mgmt.pdf#bookinfo


 Take a reliable backup of the ZENworks Server (this only needs to be done one time). For 
instructions, see “Backing Up and Restoring the ZENworks Server and Certificate Authority”in 
the ZENworks Disaster Recovery Reference.

 Take a reliable backup of the Certificate Authority. For instructions, see “Backing Up the 
Certificate Authority”in the ZENworks Disaster Recovery Reference.

Customizing ZENworks Control Center
ZENworks Control Center provides a configuration file that you can use to customize how it 
functions. For example, you can change the default timeout from 30 minutes to another value.

For instructions, see “Customizing ZENworks Control Center” in the ZENworks Control Center 
Reference.

Tasks for VMware ESX 
 For optimal performance of the Primary Servers running on VMware ESX, set the reserved 

memory size to the size of the guest operating system memory. For more information, see TID 
7005382 in Novell Support Knowledgebase (http://support.novell.com/search/kb_index.jsp).

 In addition, if the ZENworks guest operating system supports VMware ESX, enable additional 
Java commands to set large pages, as follows:
-XX:+UseLargePages
For more information on memory reservation and large memory pages, refer to the 
Enterprise Java Applications on VMware Best Practices Guide.

 Finally, you need to perform the following tasks:

1 In the CATALINA_OPTS string, add the appropriate options, separated by spaces, before the -
XX:PermSize option.
CATALINA_OPTS is used to configure the Tomcat container options. For more information on 
Tomcat, see the Tomcat Online documentation.

2 To start the ZENworks Server services, run the following command:
microfocus-zenworks-configure -c Start

NOTE: If the ZENworks Administration Management service fails to start, there is a compatibility 
problem with the newly added option, or the syntax is incorrect. To troubleshoot the service startup, 
run the following command:

/etc/init.d/microfocus-zenadmin-mgmt debug 

The following log file is displayed:

/var/opt/microfocus/log/zenworks/admin-mgmt/catalina.out
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III IIIAppendixes

The following section provide information related to installing the ZENworks Primary Server 
software: 

 Appendix A, “Creating an External Certificate,” on page 43
 Appendix B, “Dependent Linux RPM Packages,” on page 47
 Appendix C, “Oracle Enterprise with Partitioning,” on page 53
 Appendix D, “Keywords Not to Be Used in Database Creation,” on page 55
 Appendix E, “Installation Troubleshooting,” on page 57
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A ACreating an External Certificate

ZENworks Primary Servers communicate with ZENworks managed devices using the HTTPS protocol. 
This secure communication requires that the ZENworks Management Zone have a defined 
Certificate Authority (CA) and that each Primary Server have its own server certificate issued by the 
zone's CA.

ZENworks includes an internal ZENworks CA. If you use the internal ZENworks CA, it is created during 
installation of the first Primary Server. Each subsequent Primary Server you install is issued a 
certificate signed by the ZENworks CA.

We recommend that you use the internal ZENworks CA unless your corporate security policies do 
not allow you to do so. The internal ZENworks CA lasts 10 years and simplifies use of various 
ZENworks features such as Remote Management.

The following are the acceptable formats for Root certificate and Server certificate with Private Key:

 Root certificate: The top-level certificate in the certificate tree issued by the CA that signed the 
Server certificate and any intermediate certificate chains. It supports the .pem, .crt, .cer, 
.der, .p7b, or .p7c file format.

 Server certificate: It is a signed certificate that is used for the ZENworks server. It supports the 
.pem, .crt, .cer, .der, .p7b, or .p7c file format.

 Private key: The private key file that is associated with the signed server 
certificate. It supports the .der file format.

You can convert your certificate or key to ZENworks acceptable formats using the openssl command 
line tool (available as part of most Linux distributions or as part of the cygwin tool set).

For example, convert your PEM encoded private key to DER encoded thusly:

openssl pkcs8 -topk8 -nocrypt -in key.pem -inform PEM -out key.der -outform 
DER
PEM encoded certificate to DER encoded thusly:

openssl x509 -in cert.pem -inform PEM -out cert.der -outform DER

NOTE: If it is an intermediate CA, you need to provide the complete chain. ZENworks will use the 
root CA in the chain as the future CA. The top-level should consist of a root certificate, which is 
signed by the Root CA, followed by the intermediate certificates, and then the Leaf certificate 
(server certificate). 

 If it is an intermediate CA, you need to provide the complete chain. ZENworks will use the root 
CA in the chain as the future CA. The chain should begin with the server certificate, the 
intermediate or subordinate certificate authority and then root ca.
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 The supported certificate formats are .der, .cer, .crt, .p7b, .pem, .cert
 If you plan to configure Kafka or Vertica in your zone, then ensure that two-way SSL is enabled 

for the server certificate issued by an external CA. For more information on Kafka or Vertica, see 
ZENworks Vertica Guide.

See the following sections for detailed instructions on using external certificates:

 “Generating a Certificate Signing Request (CSR)” on page 44
 “Generating a Certificate by Using NetIQ ConsoleOne” on page 45
 “Generating a Certificate by Using NetIQ iManager” on page 45

Generating a Certificate Signing Request (CSR)
For each Windows server where you will install the ZENworks Primary Server software, you need to 
create an individual server certificate with the subject being the server’s Fully Qualified Domain 
Name (FQDN). 

1 Install OpenSSL.
2 To generate a private key that is needed to create a certificate signing request (CSR), enter the 

following command:

openssl genrsa -out zcm.pem 2048
3 To create a CSR that can be signed by a Certificate Authority, enter the following command:

openssl req -new -key zcm.pem -out zcm.csr
When you are asked for “YOUR name,” enter the full DNS name assigned to the server where 
you are installing the Primary Server software domain names include www.company.com, 
payment.company.com and contact.company.com.

4 To convert the private key from PEM format to the DER encoded format, enter the following 
command:

openssl pkcs8 -topk8 -nocrypt -in zcm.pem -inform PEM -out zcmkey.der -
outform DER
The private key must be in the PKCS8 DER encoded format. You can use the OpenSSL command 
line tool to convert your keys to the proper format.

5 Use the CSR to generate a certificate by using ConsoleOne, iManager, or a true external CA such 
as Verisign.
If you are using a true external CA such as Verisign, refer to Verisign for information about using 
the CSR to generate a certificate. If you are using ConsoleOne or iManager as your Certificate 
Authority, instructions are provided in the following sections: 
 “Generating a Certificate by Using NetIQ ConsoleOne” on page 45
 “Generating a Certificate by Using NetIQ iManager” on page 45
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Generating a Certificate by Using NetIQ ConsoleOne
1 Ensure that eDirectory is configured as the CA.
2 Issue the certificate for the Primary Server:

2a Launch ConsoleOne.
2b Log in to the eDirectory tree as an administrator with the appropriate rights. 

For more information about the appropriate rights, see the Entry Rights Needed to Perform 
Tasks (https://www.netiq.com/documentation/crt33/crtadmin/data/a2zibyo.html) section 
in the NetIQ Certificate Server 3.3 documentation.

2c From the Tools menu, click Issue Certificate.
2d Browse for and select the zcm.csr file, then click Next. 
2e Complete the wizard by accepting the default values. 
2f Specify the certificate basic constraints, then click Next.
2g Specify the validity period and the effective and expiration dates, then click Next.
2h Click Finish.
2i Choose to save the certificate in the DER-format, then specify a name for the certificate.

3 Export the Organizational CA's self-signed certificate:
3a Log in to eDirectory from ConsoleOne.
3b In the Security container, right-click the CA, then click Properties.
3c In the Certificates tab, select the self-signed certificate.
3d Click Export.
3e When prompted to export the private key, click No.
3f Export the certificate in DER format and choose the location where you want to save the 

certificate.
3g Click Finish.

You should now have the three files that you need to install ZENworks using an external CA.

Generating a Certificate by Using NetIQ iManager
1 Ensure that eDirectory is configured as the CA.
2 Issue the certificate for the Primary Server:

2a Launch iManager.
2b Log in to the eDirectory tree as an administrator with the appropriate rights. 

For more information about the appropriate rights, see the Entry Rights Needed to Perform 
Tasks (https://www.netiq.com/documentation/crt33/crtadmin/data/a2zibyo.html) section 
in the NetIQ Certificate Server 3.3 documentation.

2c From the Roles and Tasks menu, click Novell Certificate Server > Issue Certificate.
2d Click Browse to browse for and select the CSR file, zcm.csr, then click Next.
2e Accept the default values for the key type, the key usage, and the extended key usage, then 

click Next.
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2f Accept the default certificate basic constraints, then click Next.
2g Specify the validity period and the effective and expiration dates, then click Next. 

Depending on your needs, change the default validity period (10 years). 
2h Review the parameters sheet. If it is correct, click Finish. If it is incorrect, click Back until you 

reach the point where you need to make changes.
When you click Finish, a dialog box is displayed and indicates that a certificate has been 
created. This exports the certificate into the binary DER-format.

2i Download and save the issued certificate
3 Export the Organizational CA's self-signed certificate:

3a Log in to eDirectory from iManager.
3b From the Roles and Tasks menu, click Novell Certificate Server > Configure Certificate 

Authority.
This displays the property pages for the Organizational CA, which include a General page, a 
CRL Configuration page, a Certificates page, and other eDirectory-related pages.

3c Click Certificates, then select Self Signed Certificate.
3d Click Export.

This starts the Certificate Export wizard.
3e Deselect the Export the Private Key option, and choose the export format as DER.
3f Click Next, then save the exported certificate.
3g Click Close.

You should now have the three files that you need to install ZENworks using an external CA.
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B BDependent Linux RPM Packages

ZENworks installation on a Linux server requires that certain RPM packages are already installed on 
the server. Review the following sections for more information on the RPM packages required on the 
Linux devices:

 “SUSE Linux Enterprise Server” on page 47

SUSE Linux Enterprise Server
You can use the SUSE Linux Enterprise Server installation media to install the packages on the SUSE 
Linux Enterprise Server before starting the ZENworks installation on the server:

SLES 12 - 64 Bit SLES 15 - 64 Bit

xinetd xinetd

bash bash

libxml2 libxml2

glibc-32bit glibc-32bit

libjpeg-32bit libjpeg-32bit

zlib-32bit zlib-32bit

libgcc43-32bit libgcc43-32bit

libstdc++43-32bit libstdc++43-32bit

perl perl

coreutils coreutils

fillup fillup

gawk gawk

glibc glibc

grep grep

insserv insserv

pwdutils pwdutils

sed sed

sysvinit sysvinit

diffutils diffutils

logrotate logrotate
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perl-base perl-base

tcpd tcpd

libreadline5 libreadline5

libncurses5 libncurses5

zlib zlib

libglib-2_0-0 libglib-2_0-0

libgmodule-2_0-0 libgmodule-2_0-0

libgthread-2_0-0 libgthread-2_0-0

gdbm gdbm

libdb-4_5 libdb-4_5

coreutils-lang coreutils-lang

info info

libacl libacl

libattr libattr

libselinux1 libselinux1

pam pam

filesystem filesystem

aaa_base aaa_base

libldap-2_4-2 libldap-2_4-2

libnscd libnscd

libopenssl0_9_8 libopenssl0_9_8

libxcrypt libxcrypt

openslp openslp

pam-modules pam-modules

libsepol1 libsepol1

findutils findutils

mono-core mono-core

bzip2 bzip2

cron cron

popt popt

terminfo-base terminfo-base

glib2 glib2

SLES 12 - 64 Bit SLES 15 - 64 Bit
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pcre pcre

libbz2-1 libbz2-1

libzio libzio

audit-libs audit-libs

cracklib cracklib

cpio cpio

login login

mingetty mingetty

ncurses-utils ncurses-utils

net-tools net-tools

psmisc psmisc

sles-release sles-release

udev udev

cyrus-sasl cyrus-sasl

permissions permissions

glib2-branding-SLES glib2-branding-SLES

glib2-lang glib2-lang

libgcc43 libgcc43

libstdc++43 libstdc++43

cracklib-dict-full cracklib-dict-full

cpio-lang cpio-lang

sles-release-DVD sles-release-DVD

libvolume_id1 
(applicable only for SLES 
11 SP2)

libvolume_id1 
(applicable only for SLES 
11 SP2)

licenses licenses

libavahi-client3 libavahi-client3

libavahi-common3 libavahi-common3

libjpeg libjpeg

xorg-x11-libX11 xorg-x11-libX11

xorg-x11-libXext xorg-x11-libXext

xorg-x11-libXfixes xorg-x11-libXfixes

SLES 12 - 64 Bit SLES 15 - 64 Bit
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xorg-x11-libs xorg-x11-libs

dbus-1 dbus-1

xorg-x11-libXau xorg-x11-libXau

xorg-x11-libxcb xorg-x11-libxcb

fontconfig fontconfig

freetype2 freetype2

libexpat1 libexpat1

xorg-x11-libICE xorg-x11-libICE

xorg-x11-libSM xorg-x11-libSM

xorg-x11-libXmu xorg-x11-libXmu

xorg-x11-libXp xorg-x11-libXp

xorg-x11-libXpm xorg-x11-libXpm

xorg-x11-libXprintUtil xorg-x11-libXprintUtil

xorg-x11-libXrender xorg-x11-libXrender

xorg-x11-libXt xorg-x11-libXt

xorg-x11-libXv xorg-x11-libXv

xorg-x11-libfontenc xorg-x11-libfontenc

xorg-x11-libxkbfile xorg-x11-libxkbfile

libuuid1 libuuid1

libsqlite3-0 libsqlite3-0

libgobject-2_0-0 libgobject-2_0-0

rpm rpm

util-linux util-linux

libblkid1 libblkid1

util-linux-lang util-linux-lang

update-alternatives update-alternatives

postfix postfix

netcfg netcfg

openldap2-client openldap2-client

lsb-release lsb-release

libXtst6-32bit-1.2.2-
3.60.x86_64

libXtst6-32bit-1.2.2-
3.60.x86_64

SLES 12 - 64 Bit SLES 15 - 64 Bit
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libpango-1_0-0-32bit libpango-1_0-0-32bit

libXi6-32bit libXi6-32bit

libsecomp2

SLES 12 - 64 Bit SLES 15 - 64 Bit
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C COracle Enterprise with Partitioning

ZENworks support Oracle Partitioning, if the partitioning feature is enabled in the Oracle database. 
Oracle Partitioning is a separately licensed option available with the Oracle Enterprise edition only. 
For Oracle Standard edition, the partitioning option is not supported.

During the ZENworks installation with the Oracle database, select one of the following: 

  Yes, let ZENworks use partitioning with the Oracle database. 
  No, do not use partitioning with Oracle database.

IMPORTANT: It is recommended that you use Oracle Partitioning since it improves the application 
performance and manageability.

If you are using Oracle Enterprise with partitioning, you need to verify whether the Oracle partition 
feature is enabled with the required license.

Execute the following:

Select Value from v$option where parameter='Partitioning';

The query output value is displayed as "TRUE". This indicates that the partition is enabled. 
ZENworks will automatically run the partition table scripts.
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D DKeywords Not to Be Used in Database 
Creation

When you create databases during installation, upgrade or database migration, the following 
keywords should not be used as-is in fields such as the zone name, user name, password, database 
name, schema names:

all compress false level

alter connect fetch like

and constant float limited

any create for lock

array current forall long

as currval from loop

asc cursor function max

at date goto min

audit day group minus

authid decimal having minute

avg declare heap mlslabel

begin default hour mod

between delete if mode

binary_integer desc immediate month

body distinct in natural

boolean do index naturaln

bulk drop indicator new

by else insert nextval

char elsif integer nocopy

char_base end interface not

check exception intersect nowait

close exclusive label null

cluster execute interval nullif

coalesce exists into number

collect exit is number_base
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comment extends isolation ocirowid

commit extract java of

on range sqlcode update

opaque raw sqlerrm use

open real start user

operator record stddev validate

option ref subtype values

or release successful varchar

order return sum varchar2

organization reverse table variance

others rollback then view

out row time when

package rowid timestamp whenever

partition rownum timezone_abbr where

pctfree rowtype timezone_hour while

pls_integer savepoint timezone_minute with

positive second timezone_region work

positiven select to write

pragma separate trigger year

prior set true zone

private share type

procedure smallint ui

public space union

raise sql unique
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E EInstallation Troubleshooting

The following sections provide solutions to the problems you might encounter while installing or 
uninstalling ZENworks:

 “Troubleshooting Installation” on page 57
 “Post Installation Troubleshooting” on page 64

Troubleshooting Installation
This section provides solutions to problems you might encounter when installing ZENworks .

 “Unable to log in to ZCC if a cross-signed certificate is used” on page 58
 “ZENworks Agent install progress does not display toast messages on Windows” on page 58
 “Unable to create database schema on a Primary Server” on page 58
 “ZENworks installation fails on a SLES device with the BTRFS file system” on page 58
 “Installing from the root directory on a Linux device fails to create the self-signed certificates” 

on page 59
 “Configuring the ZENworks Server to an Oracle database fails” on page 59
 “Unable to establish a remote desktop session with a Windows device running the ZENworks 

Configuration Management installation program” on page 59
 “Installing a second server gives an error message” on page 60
 “Installation on Linux fails” on page 60
 “Configure Action fails because of an error detected by HotSpot Virtual Machine” on page 60
 “Unable to open the ZENworks Configuration Management Installation logs by using a web 

browser on a non-English Primary Server” on page 61
 “Unable to install .NET 3.5 SP1 on Windows Server 2008” on page 61
 “Unable to install the ZENworks Agent on a McAfee fully protected device” on page 62
 “ZENworks-related files might be reported as malicious software during the ZENworks Agent 

installation” on page 63
 “Installation of ZENworks Agent on a Terminal Server hangs” on page 63
 “On Windows XP, installing the ZENworks Agent with the Remote Management component 

through Remote Desktop Connection hangs” on page 63
 “ZENworks installation fails on a Linux server” on page 63
 “ZENworks installation does not proceed while using Microsoft SQL named instance” on 

page 64
 “The install XML log file is not displayed properly in Google Chrome and Firefox” on page 64
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Unable to log in to ZCC if a cross-signed certificate is used
Explanation: When configuring a zone, if the root CA certificate that is cross-signed by an 

additional CA is used, the zone configuration was successfully completed but the 
user was not able to log into ZCC as ZENworks failed to recognize this behavior. 

Action: Modify the certificate received from CA to include the latest self-signed root 
certificate. Perform the following steps:

1. Open the full chain certificate in a text editor and replace the last cross-
signed Root CA certificate with a self-signed Root CA certificate.

2. Import the modified server certificate manually.
For example: A certificate from Let’s Encrypt contains two Root CAs. They 
are:
 Self-Signed ISRG Root X1
 ISRG Root X1 cross-signed by DST Root CA X3

If the certificate chain includes 2nd certificate as a root, it should be 
removed and replaced by the first certificate.

ZENworks Agent install progress does not display toast messages on 
Windows

Source: ZENworks, ZENworks Agent

Explanation: The ZENworks agent install progress is not displayed as toast messages on 
Windows managed devices. However, when the progress notifications are 
displayed in the notification area.

Action: Set the registry key to force the toast notifications ON. On the Windows device, 
go to the following registry key:

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\PushNoti
fications , create a DWORD ToastEnabled with value 1. 

Restart the device for the setting to be effective.

Unable to create database schema on a Primary Server
Source: ZENworks

Explanation: While creating the database schema for ZENworks, Audit, or Antimalware 
database, then it is always recommended that you run setup.exe -c or setup.sh -
c on a device, which is not a Primary Server.

If you run the command on a Primary Server, then the switch -c will be 
discarded and ZENworks installation will be initiated.

Action: None

ZENworks installation fails on a SLES device with the BTRFS file system
Source: ZENworks 2020
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Explanation: When you install ZENworks 2020 on a SLES device with BTRFS file system, the 
installation fails.

Possible Cause: ZENworks installation on SLES device with BTRFS file system is not supported.

Installing from the root directory on a Linux device fails to create the self-
signed certificates

Source: ZENworks ; Installation.

Action: On the Linux device, download and copy the ZENworks  installation ISO image to 
a temporary location to which all users have the Read and Execute permissions.

Configuring the ZENworks Server to an Oracle database fails
Source: ZENworks ; Installation.

Explanation: If the NLS_CHARACTERSET parameter is not set to AL32UTF8 and the 
NLS_NCHAR_CHARACTERSET parameter is not set to AL16UTF16, the database 
installation fails with the following error messages:

Failed to run the sql script: localization-updater.sql,
message:Failed to execute the SQL command: insert into
zLocalizedMessage(messageid,lang,messagestr)
values('POLICYHANDLERS.EPE.INVALID_VALUE_FORMAT','fr','La 
stratÃ©gie {0} n''a
pas pu Ãªtre appliquÃ©e du fait que la valeur de la variable 
"{1}" n''est pas
dans un format valide.'),
message:ORA-00600: internal error code, arguments: 
[ktfbbsearch-7], [8], [],
[], [], [], [], []

Action: Set the NLS_CHARACTERSET parameter to AL32UTF8 and the 
NLS_NCHAR_CHARACTERSET parameter to AL16UTF16. 

To ensure that the character set parameters are configured with the 
recommended values, run the following query at the database prompt:

select parameter, value from nls_database_parameters where 
parameter like '%CHARACTERSET%';

Unable to establish a remote desktop session with a Windows device 
running the ZENworks  Configuration Management installation program

Source: ZENworks ; Installation.

Explanation: If you try to use a Remote Desktop Connection to connect to a Windows server 
on which the ZENworks  Configuration Management installation program is 
running, the session terminates with the following error message:

The RDP protocol component "DATA ENCRYPTION" detected an 
error in the protocol stream and has disconnected the 
client. 
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Action: See the Microsoft Help and Support web site (http://support.microsoft.com/kb/
323497).

Installing a second server gives an error message
Source: ZENworks ; Installation.

Explanation: When you are installing the second server into a Management Zone, an error 
message might be displayed at the end of the installation that contains the 
following text:

... FatalInstallException Name is null
However, the installation otherwise seems to complete successfully.

This error is being displayed erroneously because the program thinks that the 
server needs to be reconfigured.

Action:  Review the installation log file. If there are no errors there related to this error 
message, you can ignore it.

Installation on Linux fails
Source: ZENworks; Installation.

Possible Cause: If the directory path to which you have extracted the ZENworks  installation ISO 
image contains spaces, the installation fails on Linux.

Action: Ensure that the directory path to which you want to extract the installation ISO 
image does not contain spaces.

Configure Action fails because of an error detected by HotSpot Virtual 
Machine

Source: ZENworks; Installation.

Explanation: If you are installing the first Primary Server on a Linux device, and if at the end 
of the process that configures the database you see an error has occurred and 
you are given the option of continuing or rolling back, you should check the log 
file at /var/opt/microfocus/log/zenworks/
ZENworks_Install_[date].log.xml. If you see the error specified below, 
it is safe to continue with the install. 

If you are installing the first Primary Server on a Linux device, and if at the end 
of the process that configures the database you see an error has occurred and 
you are given the option of continuing or rolling back, you should check the log 
file at /var/opt/microfocus/log/zenworks/ZENworks_Install_[date].log.xml. If 
you see the error specified below, it is safe to continue with the install.

ConfigureAction failed!:
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select tableName, internalName, defaultValue from Adf where 
inUse =?#
An unexpected error has been detected by HotSpot Virtual 
Machine:
#SIGSEGV (0xb) at pc=0xb7f6e340, pid=11887, tid=2284317600
#
#Java VM: Java HotSpot(TM) Server VM (1.5.0_11-b03 mixed 
mode)
#Problematic frame:
#C [libpthread.so.0+0x7340] __pthread_mutex_lock+0x20

Action: Ignore the error message.

Unable to open the ZENworks  Configuration Management Installation 
logs by using a web browser on a non-English Primary Server

Source: ZENworks ; Installation.

Explanation: On a non-English Primary Server that has ZENworks  Configuration Management 
installed, you are unable to open the Installation logs by using a web browser. 
However, you can still open the Installation logs in a text editor.   

The Installation logs are located at /var/opt/microfocus/log/zenworks/ 
on Linux and 
zenworks_installation_directory\microfocus\zenworks\logs on 
Windows.

Action: Before opening the Installation logs (.xml) in a web browser, change the 
encoding for all the Installation LogViewer files:

1 Using a text editor, open one of the following LogViewer files located at /
var/opt/microfocus/log/zenworks/logviewer on Linux and 
zenworks_installation_directory\microfocus\zenworks\log
s\logviewr on Windows:   
 message.xsl 
 sarissa.js 
 zenworks_log.html
 zenworks_log.js
 zenworks_log.xsl
 zenworks_log_text.xsl

2 Click File > Save As. 
The Save As dialog box is displayed. 

3 In the Encoding list, select UTF-8, then click Save.
Do not change the filename and file type. 

4 Repeat Step 1 through Step 3 for the remaining LogViewer files. 

Unable to install .NET 3.5 SP1 on Windows Server 2008
Source: ZENworks ; Installation.
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Explanation: The installation of Microsoft .NET 3.5 SP1 on Windows Server 2008 fails with the 
following error message:

Microsoft .NET Framework 2.0SP1 (x64) (CBS): [2] Error: 
Installation failed for component Microsoft .NET Framework 
2.0SP1 (x64) (CBS). MSI returned error code 1058

Possible Cause: The device does not have the Windows Update Service enabled.

Action: Enable the Windows Update service on the device:

1 From the Windows desktop Start menu, click Settings > Control Panel.
2 Double-click Administrative Tools > Services.
3 Double-click Windows Update Service. 

The Windows Update Service Properties dialog box is displayed. 
4 In the General tab, select one of the following options from the Startup 

type list:
 Manual
 Automatic
 Automatic (Delayed Start)

5 Click Start to start the service. 
6 Click OK. 

Unable to install the ZENworks Agent on a McAfee fully protected device
Source: ZENworks ; Installation

Explanation: When you try to install ZENworks Agent on a McAfee fully protected device, the 
antivirus software prevents the creation of new executable files in Windows and 
program files.

Possible Cause: The device is protected by McAfee VirusScan and therefore does not allow the 
installation of any applications.

Action: Do the following on the device that has the McAfee software installed:

1 Click Start > All Programs > McAfee > VirusScan Console.
2 Double-click  Access Protection.
3 In the Access Protection Properties dialog box, do the following:

3a In the Categories panel, click Common Maximum Protection.
3b In the Block column, deselect all the rules.
3c Click OK.

4 Install the ZENworks Agent.
For more information, see “ZENworks Agent Deployment” in the ZENworks 
Discovery, Deployment, and Retirement Reference.
62 Installation Troubleshooting

https://www.novell.com/documentation/zenworks-23.4/pdfdoc/zen_discovery_deployment/zen_discovery_deployment.pdf#bataxsr
https://www.novell.com/documentation/zenworks-23.4/pdfdoc/zen_discovery_deployment/zen_discovery_deployment.pdf#bookinfo
https://www.novell.com/documentation/zenworks-23.4/pdfdoc/zen_discovery_deployment/zen_discovery_deployment.pdf#bookinfo


ZENworks-related files might be reported as malicious software during 
the ZENworks Agent installation

Source: ZENworks ; Installation.

Explanation: During the ZENworks Agent installation, some ZENworks-related files might be 
reported as malicious software by anti-virus software. Consequently, the 
installation abruptly stops.

Action: Do the following on the managed device where you want to install the 
ZENworks Agent:

1 Manually add System_drive:\windows\microfocus\zenworks to 
the Exclusion list of the anti-virus software installed on the managed 
device.
Manually add System_drive:\windows\microfocus\zenworks to the 
Exclusion list of the anti-virus software installed on the managed device.

2 Install the ZENworks Agent.

Installation of ZENworks Agent on a Terminal Server hangs 
Source: ZENworks; Installation

Possible Cause: Installation of ZENworks Agent on a Terminal Server hangs because the default 
mode in the Terminal Server is Execute.

Action: Change the mode in the Terminal Server to Install:

1 From the Command Prompt:
1a To change the mode, execute the following command:

change user /install
1b Type exit, then press ENTER.

2 Install the ZENworks Agent.
For more information, see “ZENworks Agent Deployment” in the ZENworks 
Discovery, Deployment, and Retirement Reference.

On Windows XP, installing the ZENworks Agent with the Remote 
Management component through Remote Desktop Connection hangs

Source: ZENworks; Installation

Explanation: If you remotely connect to a managed device by using Remote Desktop 
Connection (RDP) and install ZENworks Agent, the installation hangs.

Action: To fix the issue, download the patch from the Microsoft Support web site (http:/
/support.microsoft.com/kb/952132) and install it on the managed device prior 
to installing the ZENworks Agent.

ZENworks installation fails on a Linux server 
Source: ZENworks; Installation.
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Explanation: ZENworks installation on a Linux server requires that certain RPM packages are 
already installed on the server.

Action: Install the required RPM packages on the Linux server. 

ZENworks installation does not proceed while using Microsoft SQL 
named instance

Source: ZENworks; Installation.

Explanation: While using named instance for Microsoft SQL, the install wizard will not 
proceed even after providing the correct information in the database panel. This 
occurs if Checksum offloading is enabled on the NIC card of the machine. 

Action: Ensure that Checksum offloading is disabled on the NIC card. For more 
information, refer to the applicable manuals for SLES, RHEL, or VMware.

The install XML log file is not displayed properly in Google Chrome and 
Firefox

Explanation: When you try to view the install XML log file in Google Chrome and Firefox, the 
log file is not displayed properly.

Action: Run the following configure action to convert the XML log file to HTML and view 
the log file in a web browser:

microfocus-zenworks-configure -c 
ConvertLogToHTMLConfigureAction -DlogFile=<LogFilePath>
Alternatively, you can view the log file using any text editor.

Post Installation Troubleshooting
This section provides solutions to problems you might encounter after installing ZENworks .

 “Unable to access ZENworks Control Center on a ZENworks Primary Server running on SLES” on 
page 64

 “Auto Launch ZENworks Control Center configuration does not work in SLES machine” on 
page 65

 “Deployment of Antimalware Bundles, Windows Bundles, and Windows Policies with System 
Requirements Set Fails on Windows 10 or later Devices” on page 65

Unable to access ZENworks Control Center on a ZENworks Primary Server 
running on SLES

Source: ZENworks; Installation.
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Explanation: During the installation of ZENworks Server on a SLES device, if you have 
specified the port as 8080, the installation is successful. However, you might not 
be able to access the ZENworks Control Center. 

Action: Perform the following steps on the SLES device on which you have installed the 
ZENworks Server:

1 Start YaST.
2 Click Firewall.
3 In the Firewall Configuration Window, click Allowed Services.
4 Click Advanced.
5 In the Additional Allowed Ports dialog box, replace http-alt in the TCP Ports 

and UDP Ports options with 8080, then complete the Wizard.

Auto Launch ZENworks Control Center configuration does not work in 
SLES  machine

Source: ZENworks; Installation.

Explanation: In the Post installation configuration, if the Auto launch ZCC option is selected, 
after installation, ZENworks Control Center does not launch automatically in 
SLES  machines.

Action: Manually launch ZENworks Control Center. 

Deployment of Antimalware Bundles, Windows Bundles, and Windows 
Policies with System Requirements Set Fails on Windows 10 or later 
Devices 

Source: ZENworks 23.3 Update

Explanation: The deployment of Antimalware bundles, Windows bundles, and Windows 
policies with System Requirements Set fails on Windows (Windows 10 21H2 or 
later versions) as the OS version mapping information (21H2, 22H2 etc) was 
missing on the Primary Servers in the zone. This issue occurs whenever you add 
new primary server of 2020 Update 2 version.

Action: Perform the following steps:

1. Create a custom_ostargets.xml file with details of the latest platform 
version. For more information, see Creating Custom_OSTagets.

2. Add the missing entries in windowsVersionMapping.properties on 
the Primary Server, and then run the following configure action:
microfocus-zenworks-configure -c SettingsConfigureAction 
-Dtype=CustomOSTarget -Dadd
To add the missing entries, see Adding an entry in the 
windowsVersionMapping.
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